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NorthClark Computing, Inc. 

Introduction 
NorthClark’s Routing Maintenance System is used to create and maintain Routing records in your 
Manfact system (also known as Bills of Operation or “BOO” records).  The Routing Maintenance 
procedure is a Windows based desktop application that includes the following capabilities:  

� View, create and modify Routing records in your Manfact system. 

� View the impact of various lot sizes on both cost and lead-time. 

� Define multiple Tasks for each Routing Line Item.   

� Select Task Descriptions from a list of pre-defined standard operation descriptions. 

� An unlimited amount of text may be entered as Instructions for each Task. 

� Associate a list of Part Numbers and Quantities from the Bill of Material with a specific 
Task.   

� The list of Part Numbers from the Bill of Material will be displayed in a separate Window 
(same information as the pick-list).  The user may select one or more items from the list by 
clicking the check-box displayed next to each Part Number. 

� Create customized Routing Reports and Work Order Traveler documents using Microsoft 
Word™ Templates. 

Support for Engineering, History and Work Order Routings 
The NorthClark system may be used to access the following types of Routing records: 
 

• Production Routings (BOO) 
• Engineering Routings (ENGBOO) 
• Historical Routings (BOOHIST) – View Only 
• Work Order Routings (WO) – Task Management Only 

 
Historical Routing (BOOHIST) records may be viewed and printed, but not modified.   
 
Due to the complexities involved in modifying a Work Order routing, changes to the Manfact WO 
record are not currently supported in the NorthClark application.  Manfact’s WO.C procedure must be 
used to add or delete routing line items from the Work Order.  NorthClark’s Routing Maintenance 
module will however, allow maintenance of Task details associated with existing Routing steps on a 
Work Order. 

Updating Routing (BOO) History 
The system will update the Manfact NCC_BOOHIST and NCC_BOOLIHIST files when the Revision 
Level of a Routing is incremented. 
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Main Menu Options 
Following is a brief description of the options available from the Main Menu of the Routing 
Maintenance application. 

 

Menu Option Description 

File New Clear all current data on all displays and create new 
routing. 

 Delete Selecting this option will remove the Routing record 
from the file.  You will be asked if you are sure you 
want to perform this action. 

 Save Save your changes to the database. 

 Print Print the current active spreadsheet.   

 Export to Excel Export data from the active spreadsheet.   

 Exit Close the application 

Edit Copy Copy data to the Windows clipboard.   

 Cut Cut data from the field and copy it to the Windows 
clipboard.   

 Paste Paste data from the Windows clipboard.   

 Fill Update all of the selected cells from the Windows 
clipboard.   

 Zoom View, print and/or edit the expanded contents of a 
field.   

 Insert Row Insert a Row immediately above your current row. 

 Delete Row Delete the Row you are in. 

 Copy Row Copy the entire row to the Windows clipboard 
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Main Menu Options (cont.) 

Menu Option Description 

View Adjust Columns to fit Data Automatically adjust column width to fit data in 
column. 

 Adjust Rows to fit Data Automatically adjust row height to match data in a 
row. 

 Adjust Spread to fit Data Automatically adjust spreadsheet to fit data in both 
column and row. 

 Reset Columns to Default Width Resets Columns to Default Width. 

 Reset Row to Default Height Resets Rows to Default Height. 

 Show Hidden Columns Show Columns that are hidden. 

 Arrange/Hide Columns Allows user to arrange columns as needed for view.  
See further discussion in General Information section. 

Search Search Serves the same function as the [Search] button. 

 Clear Search Serves the same function as the [Clear Search] button. 

 Save as Default Search Serves the same function as the [Save as Default 
Search] button. 

 Restore to Default Serves the same function as the [Restore to Default] 
button. 

Tools Part Search See Tools Section – Part Number Search 

 Work Center Search See Tools Section – Work Center Search 

 Copy Routing See Tools Section – Copy Routing 

 Clear Routing Clears all current routing step data.  You will be asked 
if you are sure you want to perform this action. 

 System Administration Enter system parameters for this application.  Note, 
this option may be disabled if you do not have 
sufficient security privileges to perform this function. 

Help User Guide Displays this document. 

 About Displays the current revision level of the application. 
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Spreadsheet “Right Click” Menu 
These options are displayed when you right-click on the Routing Steps spreadsheet entry form: 
 

Item Description 

Copy Copy data to the Windows clipboard.   

Cut Cut data from the field and copy it to the Windows clipboard.   

Paste Paste data from the Windows clipboard.   

Fill Update all of the selected cells from the Windows clipboard.   

Insert Row Insert a Row immediately above your current row. 

Delete Row Delete the Row you are in. 

Copy Row Copy the entire row to the Windows clipboard 

Select Column Allows you to sort by the selected column. 

Select Row Used to select all the cells in a given row to facilitate copy/paste 
functions 

Arrange Columns Allows user to arrange columns as needed for view.  See further 
discussion in General Information section. 

Work Center Search See Tools Section – Work Center Search 
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Routing Maintenance 
The main screen of the Routing Maintenance application is comprised of five tabs:  

� Search Options – Generate a list of Routing records based on a variety of search criteria. 

� Results – List of records generated from the search performed. 

� General – Header information for a selected Routing record. 

� Routing Steps – Detail information for the selected Routing record. 

� Tasks – Define multiples Tasks for each Routing Step. 

Search for a Routing 
The Search Options tab is displayed with the Routing Maintenance application is started: 

 

 
 

Begin by selecting the Manfact Routing file you want to work with, Production, Engineering, History, or 
Work Order.  If you know the identifier of the Routing you wish to update, or if you want to create a 
new record, you may proceed directly to the General tab.  Otherwise, fill in some or all of the available 
search criteria and click the [Search] button to locate records in your Manfact database.  The Results tab 
will display your listing in spreadsheet form. 
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Use the [Clear Search] button to restore all search fields to the system default.   

You may also create a default search to be used on a regular basis by clicking on the [Save as Default 
Search] button.  When the search has been modified you may return the settings to default by clicking 
on the [Restore to Default] button. 

Note that certain prompts will be disabled, depending on the Routing file you have chosen.  This 
example shows the search options that are available when the Work Order file is selected: 
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Search Results 
The system displays a list of records that meet your search criteria.  From here you may print selected 
Routings or Work Orders, or open a record for editing. 
 

 
 
Choose one of the following options to open a record for editing: 

� Click on any cell on the desired row and click the [Open] button. 

� Double-click on the Row Number displayed to the left of the desired item. 

� Click the [New] button to create a new Routing. 
 
Once you have made your selection, the information from the header of the Routing record will be 
displayed on the General tab. 
 
The checkbox in the first column allows you to select records for printing.  The [Select All] and [Select 
None] buttons provide a convenient way to select or clear all the checkboxes at once.  Once the desired 
rows have been chosen, click the [Print] button, and a screen will be displayed allowing you to enter 
further printing options.  Please refer to the Routing / Traveler Printing topic for more information. 
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Routing Header Information 
Use this screen to view and update information from the header of the Routing record.  This screen is 
displayed automatically when you select a record from the Results tab.  You may also access an existing 
record, or create a new record, by entering the identifier at the Part#/Routing prompt. 
 

 
 

� To completely clear this screen, select the New option from the File menu. 

� Use the [Clear Routing] button to delete all rows from the Routing.   

� To delete an entire Routing from the file, select the Delete option from the File menu. 

� Use of the [Copy Routing] function to clone an existing routing. 

� The Manfact system will be updated when you choose the Save option from the File menu or the 
Toolbar.   

� Click the [Print Routing] button, and a screen will be displayed allowing you to enter further 
printing options.  Please refer to the Routing / Traveler Printing topic for more information. 
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General Field Descriptions: 

Field Description 

Part Id Routing ID Number 

Part Description Description of the ID if a Part Number is used for the Routing ID 
Number 

Copy Routing The Routing ID of a Master used to create this Routing record. 

Owner Plant Plant Code for the Owner of the Routing 

Standard Lot Size The number of assemblies made in a standard lot.  

Revision Level Current Revision Level of the Routing 

Revision Date Date the Current Revision became effective. 

Header Text ID Routing Text ID Number for standard Routing text. 
Note:  Users may not update BOOTEXT from within this procedure.  
Users desiring to modify the text will need to access BOO.N via standard 
Manfact procedures OR create BOOTEXT id’s via BOOTEXT.N 

Footer Text ID Routing Text ID Number for standard Routing text. 
Note:  Users may not update BOOTEXT from within this procedure.  
Users desiring to modify the text will need to access BOO.N via standard 
Manfact procedures OR create BOOTEXT id’s via BOOTEXT.N 

Customer Name The Customer Name of the Customer Number that has been assigned to 
the Part if a Part Number is used for the Routing ID Number. 

Customer Part The Customer Part Number from the Parts file if a Part Number is used 
for the Routing ID Number. 

Lead Days*Hours*Date The Routing Lead Time in Days * Hours * and the Date it was last 
calculated.  This field is system calculated and may not be maintained by 
the user. 

Calculated Yield % The Yield Percentage of the entire Bill of Operation for all Routing Steps.  
This field is system calculated and may not be maintained by the user. 

Yield Calc Date The last time the Yield was calculated.  This field is system maintained 
and may not be updated by the user. 
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Routing Steps 
Use this view to edit Routing line items.  Enter a Proposed Lot Size to see the impact on time and cost. 
 

 
 

To modify Routing Step detail, simply begin typing in the spreadsheet, or use the drop-down lists 
provided to select Department and Operation codes. 
 
Double-clicking on the row header for a given line item will cause the “Tasks” tab to be displayed for 
the selected Work Center. 
 

Routing Steps Field Descriptions: 

Field Description 

Current Lot Size The number of assemblies made in a standard lot. 

Proposed Lot Size User Entry Field for Lot Size used to perform What If calculations on 
Cost and Time for the Routing. 

Total Hours Setup + Labor + Machine + Rework Hours 

Current Unit Hours Total Hours / Current Lot Size 
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Field Description 

Proposed Unit Hours Total Hours / Proposed Lot Size 

Total Cost Total Setup Cost + Total Labor Cost + Total Machine Cost + Total 
Rework Cost + Total FOH Cost + Total VOH Cost 

Current Unit Cost Total Cost / Current Lot Size 

Proposed Unit Cost Total Cost / Proposed Lot Size 

Department Select the Department number for the manufacturing function to be 
performed from the drop-down list. 

Operation Select the Operation code for the manufacturing function performed from 
the drop-down list. 

Work Center Description Work Center Description for the Dept*Operation combination from the 
Work Center file. 

Line  Line Number for the Routing Step. 

Setup Hours Standard length of time required for setting up machinery for the 
workstation. 

Crew/Mach Size The standard number of people or machines needed to run this work 
center routing step. 

Line Hours Line hours per lot, in terms of hours, with fractional values up to four 
decimal places. 

Mach Hours Number of machine hours per unit. 

Lab Hours Line Hours * Crew Size 

Lab Rate Standard Labor Rate from the Work Center file. 

FOH Percent Standard Fixed Overhead Percent from the Work Center file. 

VOH Percent Standard Variable Overhead Percent from the Work Center file. 

Setup Cost Setup Hours * Standard Labor Rate 

Lab/Mach Cost (Labor Hours * Standard Labor Rate) + (Machine Hours * Machine Rate) 

Tot Cost Setup Cost + Lab/Mach Cost + Rework Cost + FOH Cost + VOH Cost 
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Field Description 

Rwk Hours Standard amount of time to be allocated per unit for reworking parts at 
this routing step. 

Queue Time The standard wait time for jobs at this operation step. 

Move Time The standard move time for jobs to move to this operation. 

Mach No User Defined Machine Number 

Tool No User Defined Tool Number 

Alt Mach User Defined Alternate Machine Number 

Route Instructions Double Click on Routing Instructions to enter multi lined free form text 
that will be printed on WO documents. 

Yield Percent The manufacturing yield percentage for this operation. 

Start Date Starting Effective Date 

End Date Ending Effective Date 

ECO Date ID Identifier and date of each ECO affecting this step of the routing. 

Text File ID Routing Text ID Number for standard Routing text. 

Note:  Users may not update BOOTEXT from within this procedure.  
Users desiring to modify the text will need to access BOO.N via standard 
Manfact procedures OR create BOOTEXT id’s via BOOTEXT.N. 
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Task Definition 
Use this screen to associate Tasks with a Routing line item, and enter details about each Task.  You may 
access a line item by selecting it from the Routing Steps tab, or you may scroll through the line items 
using the Navigator Bar located on the upper left corner of the Tasks tab. 
 

 
 

Information displayed on this screen includes: 
 

Field Description 

Navigator Bar The Navigator Bar allows you to scroll through the line items of the current 
Routing, and view/update the Tasks for each line item.  The BOO line item 
number is displayed in the caption (e.g., 4 of 10). 

Work Center  The Department, Operation, and Description for the current Routing line 
item. 

Task List Use the drop-down list to select a Task Description, or type a Description 
into the cell.  Default Task Descriptions are defined in the System 
Administration screen.  The Bill of Material Items and Instructions for the 
currently highlighted Task are displayed. 
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Field Description 

Bill of Material Items Use this grid to enter a list of Part Numbers associated with this Task.  The 
Part Number must exist on the Manfact PARTS file.  A warning message is 
displayed if a Part Number is entered that does not appear on the Pick-List 
for the Routing.  The Part Description is displayed by the system and may 
not be changed. 

Select Parts From Picker Click this button to select Part Numbers from the Pick-List. 

Instructions Free-form multi-line text entry. 

Selecting Part Numbers From the Pick-List 
This screen is displayed when the [Select Parts From Picker] button is clicked.   
 

 
 
The Pick-List information is determined as follows: 
 

Released Work Order - Read PICKER file 

Unreleased Work Order - Explode WOBOM 1 Level 

Production Routing - Explode BOM 1 Level 

Engineering Routing - Explode ENGBOM 1 Level 

History - Option Not Available 
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When this screen is displayed, any Part Numbers already defined for the Task will be pre-selected.  The 
user may then add or remove parts from the list by checking/un-checking each item as desired. 
 
You may change the Lot Size and/or Effective Date, then click the [Reload] button to reload the Pick-
List. 
 
 
Routing / Traveler Printing 
To print Routings or Work Order Travelers, begin by selecting the Routing File you wish to use 
(Production, Engineering, History, or Work Order) from the Main screen.  There are two ways to select 
the Routings or Work Order Travelers you wish to print: 
 

1. Select a population of records by entering your criteria on the Search Options tab.  Review the 
Results list, and choose the items you wish to print by clicking the check box located in the first 
column of the spreadsheet.  Click the [Print] button. 

 
2. Open a record for editing, then click the [Print Routing] button located on the General tab. 

 
This screen is displayed when you click either of the Print buttons.  The caption at the top of the screen 
displays the number of records that have been selected for printing: 
 

 
 
Select the Name of the Report you wish to print.  Before using this feature, your reports must first be 
defined using the System Administration function.   
 
The program creates a Microsoft Word Document for each Routing or Traveler.  If you chose the option 
to “Open and Display Each Word Doc”, you will have the opportunity to view the document in 
electronic form.  If you are printing a large number of documents, you will want to turn this option off.  
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When you select the option to “Print Each Routing/Traveler”, the output will be directed to your default 
Windows printer. 
 
The Effective Date and “Print Expired Rows” options are not applicable to Work Orders. 
 
Technical Note:  Any temporary files needed by the application will be stored in the user’s working 
directory, and are automatically deleted when the program shuts down.  The location will vary 
depending on the operating system, but a typical path would be:   C:\Documents and 
Settings\MyUserName\Local Settings\Temp\NCC_BOO. 
 

Example #1 - Operation Inspection Log 
This is an example of a Routing printout that may be created using the application: 
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Example #2 - Work Order Traveler 
This is an example of a Work Order Traveler that may be created using the application: 
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Tools and Utilities 

Part Number Search 
The Part Number Search Query helps you locate a Manfact Part Number using a variety of search 
criteria.  Please see Part Search Query User Guide for more information. 

Note:  The NCC Part Number Search Query is sold separately.  If this option is not currently available, 
please contact your System Administrator or NorthClark Computing, Inc. to obtain a copy of 
NCC_PARTSQ. 

Work Center Search 
The Work Center Search screen may be accessed from the Tools menu, or from the right-click menu 
available on the Routing Steps spreadsheet entry form. 
 

 

Enter the Work Center Identifier and/or Description you want to search for.  Use wildcarding to enter a 
portion of the field if desired.  Click the [Search] button to see the results.  If you are updating a 
Routing, you may double-click a row, or highlight a row and then click the [Select] button to copy the 
Work Center identifier to the Routing Steps spreadsheet entry form. 
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Copy a Routing 
To create a new Routing from an existing record, begin by entering the new identifier at the  
Part#/Routing# field on the General tab.  Next, click the [Copy Routing] button (this option may also 
be found on the Tools menu). 

 

 
 
Enter the identifier of the Routing you wish to copy and click [OK].  You may be prompted to answer 
some or all of the following questions.  Click [Yes] or [No] for each prompt: 
 
� OK to replace existing line items? 
� Copy Effective Date 
� Copy Routing Instructions? 
� Copy Issue Points? 
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System Administration 
The System Administration screen is accessed from the Tool menu of the Routing Maintenance 
application.  If the user does not have sufficient security privileges to perform system administration, 
this option will be disabled. 

Task Descriptions 
Use this screen to enter default Task Descriptions for use during Routing Entry. 
 

 
 

Routing / Traveler Report Mapping 
NorthClark has provided sample Word Templates to produce the Work Order Traveler and Operation 
Inspection Log reports illustrated in this document.  These templates may be modified by the customer, 
and the customer may create additional templates as desired. 
 
There are two distinct ways in which data is merged into a Microsoft Word Template.  The first method 
uses Field Codes to place data at a specific location on the form (this technique is commonly used in 
mail-merge applications).  Field Codes are used for data that does not repeat (Header fields) such as the 
Assembly Number, Work Order Date, etc.   
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View Word Field Codes 
A list of Header fields that are available for export can be viewed from the Help menu of on the System 
Administration window: 
 

 
 
 
The second method for exporting data to a Microsoft Word Template is to use a Table.  Tables are used 
for multiple rows of repeating data, such as Work Center and Task information.  The Table is inserted 
into the Word Template and comprises the body of the document.  The Table may have any number of 
columns, and the text may be formatted as desired.   
 
The user may create a variety of reports by entering “Report Maps”.  Each Report Map is associated 
with a Word Template, and defines the information to be exported to the report.  The following example 
shows the Report Map needed to produce the Work Order Traveler document illustrated in this 
specification. 
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Routing Report Mapping - Example 
 

 
 

Information displayed on this screen includes: 
 

Command Description 

Map 
Description 

Create one Map for each Routing or Work Order Traveler report you wish to define.  
To access an existing Map, select it from the drop-down list. 

New Map Click this button, and the system prompts you for the name of the New Map you 
wish to create. 
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Command Description 

Copy Map Click this button to create a new Map using the information from the Map currently 
displayed.  The system prompts you for the name of the New Map you wish to 
create. 

Delete Map Click this button to delete an existing Map. 

Template Path Word Templates should be stored on a public area of the network accessible to all 
users.  The pathname entered here will be used as a default, and individual users 
may change their settings if necessary. 

Template Name The name of the Microsoft Word Template designed for use with this report. 

 

Mapping Instructions define the data elements to be exported to the body of the document: 

Option Description 

Section The available fields are grouped into three sections: Work Center, Tasks, and BOM 
Items.   

The program will always print Work Center data first, followed by the Tasks, 
followed by the BOM Items.  Within each Section however, the data will be printed 
in the order entered here. 

Field Name The drop-down list allows you to choose from a list of fields available for this 
Section, including a “(Text Only)” option. 

Column# The column number where the data is to be placed in the Word Table. 

Caption Enter text to be printed in front of the data specified by Field Name. 

Line Spacing Single, Double, or None.  Use Single or Double to add line breaks to the report. 

 

Data Available for Export 

Header Data: 

Field Code Applies To Description 

ASSY_NO ALL Assembly Part Number 

ASSY_DESC ALL Assembly Description 

ASSY_QTY ALL Lot Size or Work Order Quantity 
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Field Code Applies To Description 

ASSY_REV ALL The Assembly Revision Level from field #4 of the WO file, or 
field #22 of the PARTS file. 

BOOTXT_HEAD ALL Text associated with BOO Header Text Identifier. 

BOOTXT_FOOT ALL Text associated with BOO Footer Text Identifier. 

CUST_NAME ALL For Work Orders, the Customer Name from the Sales Order 
associated to the WO, otherwise from NCC_BOO Header. 

CUST_PART ALL For Work Orders, the Reference Part# from the Sales Order 
associated to the WO, otherwise from NCC_BOO Header. 

TOTAL HOURS ALL Total Labor Hours 

TOTAL COST ALL Total Labor Cost 

UNIT HOURS ALL Total Labor Hours / Lot Size 

UNIT COST ALL Total Labor Cost / Lot Size 

LIFE_PHASE BOO Lifecycle Phase 

OWNER_PLANT BOO Owner Plant 

REV_LEVEL BOO Routing Revision Level 

REV_DATE BOO Routing Revision Date 

LEAD_DAYS BOO Lead Time Days 

LEAD_HOURS BOO Lead Time Hours 

LEAD_DATE BOO Date Lead Time calculated 

YIELD_PCT BOO Yield Percent 

YIELD_DATE BOO Date Yield Percent calculated 

WOID WO Work Order Number 

WO_ENTERED WO Work Order Entry Date 

WO_RELEASE WO Work Order Release Date 

WO_REQUIRED WO Work Order Required Date 
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Field Code Applies To Description 

WO_NOTES WO Work Order Notes 

WO_PROJECT WO Work Order Project Number 

WO_SO WO Sales Order Number associated to Work Order 

WO_SOLI WO Sales Order Line Item Number 

WO_STATUS WO Status of the Work Order: New, Firm Planned, Released, Pulled, 
Back Ordered, Complete, or Final. 

WO_ROUTING WO Identifier of Routing used on the Work Order (usually the same as 
the Assembly Number). 

WO_WIPLOC WO Work in Process Location 

WO_FGLOC WO Work Order Finished Goods Location 

WO_PRIORITY WO Work Order Priority 

WO_COMP_TYPE WO Work Order Completion Type 

 
Line Item Data: 

Data Applies To Description 

Department ALL Work Center Department 

Operation ALL Work Center Operation 

WKC Description ALL Work Center Description 

Routing Line# ALL Line Item Identifier 

Setup Hours ALL Setup Hours 

Crew/Mach Size ALL Crew/Mach Size 

Line Hours ALL Line Hours 

Machine Hours ALL Machine Hours 

Labor Hours ALL Labor Hours 

Labor Rate ALL Labor Rate 

FOH Percent ALL Fixed Overhead Percent 

VOH Percent ALL Variable Overhead Percent 

Setup Cost ALL Setup Cost 
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Data Applies To Description 

Machine Cost ALL Machine Cost 

Total Cost ALL Total Cost 

Rework Hours ALL Rework Hours 

Queue Time ALL Queue Time 

Move Time ALL Move Time 

Machine No. ALL Machine Number 

Tool No. ALL Tool Number 

Alt. Machine ALL Alternate Machine Number 

Route Instructions ALL Route Instructions 

Yield Percent ALL Yield Percent 

Issue Point ALL Issue Point 

Text from 
BOOTEXT 

ALL Standardized text from Manfact’s BOOTEXT file. 

Machine Rate ALL Machine Rate 

Schedule Method ALL Schedule Method 

Task Seq# ALL Sequence Number - Multiple Tasks per Routing Line Item 

Task Description ALL Task Description – Free form text 

Task Instructions ALL Task Instructions – Free form text 

Part Number ALL Multiple Part Numbers may be associated to a Task. 

Part Description ALL Part Description 

Part Ext. Quantity ALL Picker quantity 

Start Date BOO Starting Effective Date 

End Date BOO Ending Effective Date 

ECO Date and ID BOO Engineering Change Order Date and Identifier 

W+WO#+%+LI#  WO This field is intended for use with Bar Coding applications.   

Actual Labor Hrs WO Total actual labor hours incurred to date. 

Actual Mach Hrs WO Total actual machine hours incurred to date. 

Current Qty WO Quantity currently at the Work Center. 

Balance Due Qty WO Quantity remaining to complete at the Work Center. 
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Security 
Access to the NorthClark Routing Maintenance Module is controlled by the Manfact Security system.  
The following “procedures” may be added to a user profile. 
 

Procedure Description 

NCC_BOO Allows the NCC_BOO program to be started in “read-only” mode.   

NCC_BOOADMIN Same privileges as NCC_BOO, and also permits access to the System 
Administration screen. 

BOO.N Permits update of Manfact BOO records. 

ENGBOO.N Permits update of Manfact ENGBOO records. 

WO.C Permits update of Manfact WO records. 

 
Note, the user must have permission for either NCC_BOO or NCC_BOOADMIN to start the 
application.  Thereafter, the updates the user is allowed to perform are governed by their current 
Manfact privileges. 

Manfact Engineering Change Control 

Mass Changes Using ECO02 
The Manfact Engineering Change Order (ECO) module includes a mass change feature (ECO02) that 
may be used to update BOO records.  When changes are made, an “End Date” is posted to the existing 
line item, and a new line item is inserted with an “Effective Date” one day after the End Date of the 
original line item.  This practice is also recommended when making manual changes, as it provides a 
clear audit trail (as opposed to just modifying the existing line item). 
 
The ECO02 process may be modified so that Task details will be copied to newly created line items.  
These updates are available from NorthClark Computing, Inc. upon request. 
 

Moving Routings from Engineering to Production Files (ECO04) 
The ECO04 process may be modified to copy records from the NCC_ENGBOO and NCC_ENGBOOLI 
files.   These updates are available from NorthClark Computing, Inc. upon request. 

BOO.N and ENGBOO.N are Obsolete 
The BOO.N and ENGBOO.N procedures will not support entry of Task details.  While these procedures 
will still function, they should be considered obsolete.  Using BOO.N or ENGBOO.N to increment the 
Revision Level, or to change the Department, Operation, or Start Date on any line item, may result in a 
loss of Task information 
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General Information 

Printing a Spreadsheet 
Below is a sample of the screen that will appear when you select the Print option.  This will print the 
current active spreadsheet, so be sure to click on the spreadsheet you wish to print before choosing the 
Print option. 

 

Range - Selecting a Print Range  

You may choose to print the entire spreadsheet (all), selected cells (those that you have highlighted 
on the current screen), the current page (only the rows that are currently visible on your screen), or a 
range of page numbers.  

Orientation - Portrait or Landscape  

You may print your report in portrait mode (normal) or landscape mode (sideways). Printing in 
landscape mode will allow you to fit more columns of information on your report.  

Margins - Report Margins  

You can make your report more attractive by setting the top, bottom, left, and right margins. Reduce 
the left and right margins if you need to fit more columns on the report.  

Zoom Factor  

What percentage is required to fit the report on one printed page?  

28 



NorthClark Computing, Inc. 

Page Order  

If your report is too wide, it may span multiple pages. When this occurs, do you want the report 
printed from top to bottom or left to right?  

What Do You Want to Print?  

You can customize the appearance of your report by printing (or not printing) column headers, row 
headers, grid lines, borders, shadow, and color.  

Headers and Footers  

Your report may have up to three lines for the heading, and one line for the footer. The system 
initially displays a default heading, which you may modify if desired.  

Tip: Use /p to designate a page number.  

Which Columns Do You Want to Print?  
The columns that are available for printing are listed. Select the columns you wish to include on your 
report.  

[Preview] Button 
Click on this button to see a preview of the spreadsheet you are about to print. 

Exporting a Spreadsheet to Excel 
Below is a sample of the screen that will appear when you select the Export to Excel option.  This will 
export the current active spreadsheet, so be sure to click on the spreadsheet you wish to print before 
choosing the Export option. 

 

Export to File in Excel Format (Save As File Name) 

Enter the pathname of the file you wish to create.  You may Browse the files by clicking the button to 
locate the drive and folder where the file will be stored. 
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Export Directly to Excel 
Enter the Excel sheet name to create. This will automatically default to Sheet1. 

Generate Warning List? 
Select this option to create a log file. The log file contains error messages and other information about 
how your Excel file was created. The name of the log file is "CreateExcelFile.log", and it will be stored 
in the same folder as your spreadsheet. 

Include Header? 
If checked the spreadsheet will include column headings. 

Export Button 
After all required information has been entered, click this button to export your data to Microsoft Excel. 
 

Editing Features 
Copy, Cut, Paste and Fill 
You may use the standard Windows Copy, Cut, and Paste features to copy data to the Windows 
clipboard, or to paste data from the clipboard into a cell.  

To copy data, hold down the left mouse button and highlight one or more cells, then choose Copy. 
There are multiple ways to enter this command:  

1.  From the Edit menu choose Copy. 

2.  Click the Right Mouse button, and then choose Copy from the pop-up menu.  

3.  Click the corresponding icon on the toolbar.  

4.  Hold down the Ctrl key and type the letter C (Ctrl-C). 

You can use the Cut command (Ctrl-X) and the Paste command (Ctrl-V) in similar fashion.  

To copy the contents of an entire row, click once on the row header (the number displayed on the left 
side of the first cell), and then choose Copy. Now click on the row header that you want to copy the data 
to and choose Paste. 

If you want to update several cells with the same value, highlight all of the cells you wish to update then 
choose Fill Cells. This command will update each cell with the current information from the clipboard. 

Zoom 
This feature allows you to view, print and/or edit the expanded contents of a field.  It is especially useful 
for multi-line information such as notes and long descriptions. 

� You may "Zoom in" on any selected item by selecting Zoom from the Edit Menu or selecting 
Zoom from the right click menu.   
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� If the field is available for updating, click [OK] when finished, or [Cancel] to revert to the 
original data.  

� To print the selected item, click on the printer icon and the information will be sent to your 
local printer. 

Locked fields may be viewed but not modified using the Zoom Feature.  If the field is locked, "View" 
will appear in the Title Bar, and there will only be a single command button labeled "Done". 

Customizing Your Display / Arranging  & Hiding Columns 
Each user may adjust the column order, and hide unwanted columns, to suit their preferences.  First, 
click on the spreadsheet you want to modify, then choose Arrange / Hide Columns from the View 
menu. 

 

 
 

Hiding Columns 
To hide a column, remove the checkmark that appears under the column heading.  Click the [OK] 
button and when you return to the screen you will notice that the column no longer appears.   
To restore the hidden column either re-enter the checkmark under the column heading, or select the 
Show Hidden Columns option from the View Menu. 

Changing the Column Sequence 
To move a column, begin by clicking on the column header to select it.  This will change the column 
color to blue, as shown in the example above.  Next, select the appropriate button to move the column to 
the desired location: 

 
Move First -- Move the column to the first position on the screen. 
Move Left -- Move the column one column to the left. 
Move Right -- Move the column one column to the right. 
Move Last -- Move the column to the last position on the screen. 
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Reset to Default 
To return the screen to the original design, click [Reset to Default] to return columns to their original 
position. 

Freezing Columns and Rows 
You may freeze columns and/or rows so they are always visible.  To do this select the number of 
columns and/or rows you wish to freeze. 

Saving the changes 
Click [OK] to save your changes.   

Note, these settings are stored in the Windows Registry for each user. 
 

Wildcarding 
Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry. Here are some examples of wildcard commands and their expected results: 
 

Prompt User Entry Result 

Part No. XTR…  
or XTR* 

Returns part numbers that begin with “XTR”  

Description …VALVE… 
or *VALVE* 

Returns parts with the word “VALVE” anywhere in the description.  

Category …A  
or *A 

Returns parts with a category ending with the letter “A”.  
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